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It’s a new year! I don’t know about you, but

New Ortho2.com

boy am I ready for it. 2020 was a doozie.

Throughout much of 2020,

Ortho2 has some new things going on this

we have been hard at work

year, and I wanted to make sure you are

developing a new Ortho2.com.

aware of them.

With both existing users and
prospective clients in mind, the

Live From Iowa – A UGM
Special Event

new website offers a much more
streamlined and straightforward

While I was saddened to announce the

experience. This new, easy-

postponement of our annual Users Group Meeting, I am delighted

to-navigate website features vivid images, redesigned videos, and

to tell you about this virtual event. Live From Iowa – A UGM Special

concise text. Existing Edge Cloud users can more easily explore

Event is a one-day virtual meeting that will give you access to

facets of the software they may not be utilizing, and ViewPoint users

experienced Ortho2 trainers who will teach on various topics to give

can take a deep dive into all Edge Cloud has to offer. Note: The

you and your team the tools you need to use Edge Cloud to the

secure and customer-only facing portion of our website might not

fullest. And the best part, this UGM Special Event is free! I hope you

be fully complete at the time you are reading this, but rest assured

will join us on Friday, February 19, 2021. The meeting will run from

is coming soon. This new design will also feature a more streamlined

9:00 A.M. to 5:30 P.M. Central time and will feature such classes

and user-friendly experience for you and your team including help

as Edge Cloud 101, working smarter in Edge Cloud, new features

documentation and videos, accounting services, support tools, and

of Edge Cloud, and marketing with Edge Cloud, to name a few.

more.

Registration is now open, so sign up your office today at
www.ortho2.com/ugm. And be sure to reserve January 27-29, 2022

inVisit – Virtual Appointments by Ortho2

on your calendar for our 37th annual Users Group Meeting in Las

And last but certainly not least, inVisit. I first wrote about inVisit,
President’s Perspective continued on page 14

Vegas.
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THE NEW ORTHO2.COM
You have probably already seen the new Ortho2.com, but in
case you haven’t, we’d like to walk you through some of the
changes.
If you are looking for help videos and documentation or
integration specs, the easiest way to find it is to visit
support.ortho2.com. This direct link will take you to the login

We are excited for our virtual Users Group Meeting in 2021! We are sad we
won’t be able to see each other in person, but we still want to bring you
the best information about Edge Cloud.
Mark Friday, February 19, 2021 on your calendar for Live From Iowa: A
UGM Special Event.

page for the customer site of Ortho2.com. It features a more
streamlined navigation system so you can easily find the
information you are looking for.
In addition, you should go to support.ortho2.com to get
remote support from the Software Support, Network
Engineering, and New Customer Care Teams, and to log
into your Ortho2 account to access your Ortho2 financial
information.

This free, one-day online workshop will feature classes from our
experienced Ortho2 trainers about various topics to give you the tools you
need to use Edge Cloud to the fullest. We’ll even have trainers on hand to
answer your most pressing questions.
And while there won’t be a costume contest, we encourage you to dress in
your best flannel and ball cap to show your Iowa state spirit.

You may even want to explore the Edge Cloud page to
view all the features in Edge Cloud. This benefits both Edge
Cloud and ViewPoint users so they can learn more about all
the ins and outs of Edge Cloud. Find this by hovering over
Our Solutions in the main menu > Edge Cloud.
We hope you enjoy the new features of Ortho2.com!

Register now at www.ortho2.com/ugm.

Are you the only person in your office who sees the
newsletter? Pass it along!
You can also read the newsletter on our website
www.ortho2.com > Our Company > Newsletters.
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EDGE CLOUD TIDBITS

The 2021 virtual Users Group Meeting is coming up next

right of the message. Then, use the drop-down menu

How Dr. Edward Cronauer ended up with Edge Cloud in

month. To get ready for Live From Iowa: A Special UGM

where you type in the text message to access that text

his orthodontic practice actually started with his father’s

Event, let’s talk about using Edge Cloud to its fullest

again.

orthodontic practice. His father, the senior Dr. Edward

potential. The Edge Cloud software is a jack-of-all-trades. It
is powerful because of the many features it has throughout

Patient Widgets

the software. So many in fact, that many of them often get

•

There are six different patient widgets you can add to

overlooked. Here are some lesser known features that can

the patient information panel to customize what you

easily get overlooked, but can help you work smarter. An

see. When you are in a patient’s folder, click the Widget

ongoing theme of the UGM Special Event!

Library in the main menu. In the Patient Folder tab, you
will see the options for the Patient Folder Widgets. Click

Financial and Insurance
•

When posting AutoReceipts, have you ever accidentally
skipped one you shouldn’t have? If you catch yourself
before the end of the day, you can undo this skip. Look

•

•

shadowing his dad and even assisted in setting up a new
office after a move. He recalls OneTouch being easy to

If at any time you want to delete a section, simply hover

that the senior Dr. Cronauer received from Ortho2 was

proficiency of the support staff if he needed help with the

over the heading of the section and click the X. These

important for making decisions in his own practice.

software, and the level of customization of forms, letters,

Seeing first hand how the software worked, and the support

Fast forward to 2020, where Dr. Cronauer acquired a

and reports.

Patient Folder

it as Glades Orthodontics. The operation has three offices

was easy to reach and despite the software being decades

•

Visual tags can be created and assigned to patients and

in Florida. When Dr. Cronauer took over the practice, all

old, they still had techs that knew their way around it so well,

the Electronic Insurance Queue. You only have a few

responsible parties. Visual tags consist of user-defined

the patient charts were still on paper, and the only software

they could fix nearly anything within minutes. This definitely

seconds to undo this, though.

shapes and colors that can be used to “tag” a record for

was for the schedule and to manage financials. Dr. Cronauer

played into my decision to go with Ortho2 in my office,

classification or subgrouping purposes. Visual tags are

explained the challenge of having paper charts to cover

as the support was great and their continued support for

visible in the patient record, responsible party record,

three office locations, especially when patients would be

legacy software instead of forcing users to switch was much

Patient Tracker, and Post Payment window.

seen at multiple locations. His first order of business when

appreciated.”

You also have an Undo option after you click Delete in

Sometimes ledgers can be confusing after you reverse

even if they happen on different dates. To do this, go

You can create your own visual tags by going to Editors

into the Filter bar and check Group Adjustments.

> Visual Tags. Commonly used examples include: Needs

Want to fill in the Remarks line on the insurance forms?
In a patient folder, open the Insurance tab. Then, click
on the ADA Form fields line, check the Custom box next
to Remarks, and type away.
Have you ever wanted to bill insurance for something

Because of the coronavirus, implementing Edge Cloud was
different than expected. Instead of on-site training, the team
was trained remotely, and because of shut downs, the team

Prefers Dr. X.

Cronauer was also looking for a cloud product for his

couldn’t start using Edge Cloud right away. Dr. Cronauer

software. “I have a degree in computer science from

said the bright side of this situation was the team had more

college, so I am pretty proficient with technology,” he said.

time to learn menus, features, and customize letters and

“I considered implementing a central server and connecting

reports to their needs.

Edge Cloud Tidbits continued on page 14

About the Author
Derek Dohrman, Advanced Tech &
Trainer, has worked at Ortho2 for 15

Additional Services Provided area to bill insurance for

years and has done countless on-site

anything you want that has an insurance code.

and remote trainings. He enjoys playing
games, video and board, trail walks
with his dog, and keeping up with new
computer technology.

over and over in text messages to patients? Save text
messages for the future by clicking the Save icon to the

to digital charting.

Extra Time, Special Financial Arrangement Made, and

In the Insurance tab of the patient folder, use the

Tired of typing “Come on in, we are ready for you now”

looking for a practice management solution was to transition

While looking for solutions to his charting problem, Dr.

that is included in the contract? Records for example.

Patient Communication
•

Dr. Cronauer, Jr. remembers spending a lot of time

He remembers, “When my father did run into issues, Ortho2

so the adjustment is right next to the payment or charge

•

Ortho2’s MS-DOS practice management software.

practice from a retiring doctor in February, and re-branded

where the skip was originally made.

or adjust payments or charges. You can filter the ledger

•

30 years. During that time, Dr. Cronauer, Sr. used OneTouch,

transition onto new computers and servers after the move.

what they want to.

Screen. You can only undo the skip from the computer

Cronauer, was an orthodontist in south Florida for more than

any of these to add it to the patient folder.

widgets are user-specific, so each user can see exactly

for the Undo Skipped option in the AutoReceipt Review
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THE ORTHO2 LEGACY

the offices via VPN connection like I did for my father. My
prior associate job used Dolphin running on a central server.
While it definitely can be done and function well, I decided
the advantages of the cloud outweighed the central server –
easier IT management (I could do it myself with less hassle),
outsourcing backup and security management to Ortho2,
and access to office data on my phone or computer from
virtually anywhere without a VPN.”
In addition to the benefits of the cloud, Dr. Cronauer

Contact Info: ortho2support@ortho2.com • 800.346.4504

Now that Glades Orthodontics is open again, Dr. Cronauer
has seen many benefits from Edge Cloud. “It’s really nice
to be able to work from home and look up patient charts
when needed outside the office,” he said. “I really like all of
the reports I can run and my ability to monitor the practice.
I was pleasantly surprised to find out that I can upload my
patient’s final model scans into their charts in Ortho2, which
is a great way for us to save them with no limit on file space
and automatic backups.”

decided on moving to Edge Cloud because of the
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TERRIFIC THOUGHTS IN
TOUGH TIMES
General Colin Powell addressed the 2000 AAO meeting in a

be to spread the virus. Most important thing I learned?

Have COVID-19 protocols overwhelmed your front desk

comfort zone may be the best way to reach parents. Texting

powerful opening session. I sat near the front mesmerized,

Patients really watch us work now – everything we do is

and affected your connection with patients and parents? If

deband photos, funny smiles, doctor/patient action shots or

and wrote a quote down that he said to us. It certainly

important.”

so, you’re not alone. Since quarantine began, all of us have

videos to parents waiting in the car can be a surefire way to

learned to deal with the changes in patient care. Whether

get some love on social media. Remember to post to your

you are seeing a first-time patient or a deband, the process

social media as much as possible with images of your team

of moving a patient from parking lot to chair has become

and practice, and the ways in which you are staying safe

extremely challenging. Our reception areas are closed and

and creating amazing smiles. Posting on social media is key

most practices are replacing them with cars, using texting

to helping parents feel safe and comfortable with your new

or phone calls to move patients through. In most cases,

protocols.

applies today, “If you’re not riding the wave of change,
you may find yourself beneath it.” Look back throughout
the years at the many changes in orthodontics. But also
look back only to March and see the many changes in your
practice, your physical office, your patient care delivery,
your communication, and in YOU, yourself. I talked with a
team about this recently as I observed patient care in their
quality orthodontic/pediatric dentistry practice.
Rather than hear MY words to describe how they feel about
work today, I want to share THEIR thoughts and words with
you. I merely said to them, “Tell me how life back at work
has changed since the pandemic.” It was my joy to hear
them share more good thoughts than unhappy or regretful
ones.
Welcome to the heart of Team Styrt.
Dr. Styrt, Orthodontist, “I now have a real attitude of
gratitude and find I focus much more on important things.
I see how happy my team is to see each other and be
together. They’re not afraid, we’re very careful, our patients

Dina, Clinical Specialist/RDA, “Have to admit, I sure don’t
like wearing this PPE, especially the times when it is not
needed. I now have a wider perspective on how I see just
about everything and am more mindful and sensitive to
what others might be going through. I am so sorry I can’t
hug my teammates and my patients when I want to. I do
love hearing patients tell me how they are happy being with
their family more. The greatest change for me? I‘ve had to
learn how to smile with my eyes.”
Colette, Clinical Specialist/RDA, “I am so grateful to
have both my job AND my health. I love that our patients
are well and so happy to be here to see us – that put our
practice stats up and we’re really busy. I do want the kids
back in school – so many of them are home alone when
mom and dad are at work now. Many parents don’t know
the teaching technology and had to hire tutors to help their
kids. The saddest thing for me? Both of my parents got
the coronavirus, and my step-dad died from it. I know the
seriousness of this pandemic.”

this means lots of texts, calls, and frustrated patients and
parents in your parking lot.

Using video conferencing technology has been a game
changer over the pandemic. Most families have learned

So how do we overcome these missed connections and

to use Zoom or video conference very effectively and

front desk frustrations and still maintain our COVID-

therefore connecting with you at the practice this way is

19-appropriate workspace? Technology can make the

not out of the norm for them even though it might be for

difference in how we practice right now. Frustrated

you. Virtual appointments have become necessary with

front desk team members are finding success with

patients who can’t or don’t feel comfortable coming to the

communication technology. Texting your current patients

practice in person. Virtual visits, initial consultations, and

through Edge Reminders from Ortho2 with COVID-19

recall appointments have become more frequent and more

and first appointment forms has been very effective.

effective as we have all learned to use conferencing to our

Other texting platforms such as Weave also offer similar

benefit. Many practices have found that technology can

functionality. My Smile Appointment uses a dashboard to

assist in ways they never dreamed of before.

automate the check-in and screening process eliminating
the need for back and forth communication and freeing

Grow outside your box and find ways to bring your parents
and community closer.

are glad to be here and see our efforts to protect them.

Patty, Practice Administrator/Treatment Coordinator,

your front desk to focus on patients. It also has a

Best thing for me? I lost no team members during this

“We’re so good now at educating our patients on the

component for parent communication and video chatting.

The in-person communications you had pre-COVID-19 can

phone, in emails/texts, and verbally once they are here on

All of these systems help you move patients through faster

now be done through technology. Volunteering to sponsor

what to expect. I’m blessed to have my grown daughter

and more effectively.

school events, charities, or sports can all be done over text.

trying time; they all happily came back.”
Dr. Hayes, Pediatric Dentist, “Being a professional, I
wonder daily how will dentistry fare through this? How will
many stay afloat and keep up with all the information and
changes coming at us every day? My biggest concern? Can
I give the best care and advice to my patients and families?
Then I go home to a seven- and a four-year-old who want to
ride bikes, take walks, and need homework time. We are a
closer family now – at home and at the office for sure.”
Mackenzie, Clinical Specialist/RDA, “Some of our patients
were scared to come back and I know we must reassure
them by telling and showing them all we have learned and
done to protect them and ourselves. I am so much more
cautious of how careful I have to be and how easy it can

Terrific Thoughts continued on page 15

About the Author
Rosemary Bray spent 30 years employed
as a team member herself and now
more than 21 years as a consultant and
speaker in orthodontics and dentistry.
She has traveled the world in the name
of teeth and is honored to be the
2021 recipient of the prestigious AAO
Outstanding Service Award.
Contact Info: rosemarybrayortho@gmail.com • 760.330.9996
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WHEN YOUR RECEPTION ROOM IS A
CAR, TECHNOLOGY IS YOUR FRIEND

In addition to frustration at the front desk, we are also
seeing a lot less of the parents of our young patients. In
some cases, doctors and team members have chosen an in-

Technology continued on page 15

About the Author

person method to communicate with parents, running out
to see parents in the car after each visit. Other doctors have

Beth Leach is principal

found that video chats, calling, and texting results of the

in PracticeMarketer, and

visits through an online platform works better and is more

PracticeRetriever. She is an expert

efficient. None of these solutions gives us the same level of

in combining the latest online

interaction we had pre-COVID-19 with our patient families,

marketing strategies with the most

but they are effective ways of communicating during these

effective traditional modes of practice

times.

promotion.

Connecting with parents is crucial and winter months make
it harder for in-person outside chats. Getting out of your

Contact Info: beth@practicemarketer.com • 818.459.3784
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ALIGN YOUR PRACTICE FOR THE FUTURE OF ORTHODONTICS

Reflecting on my 45 years in the dental and orthodontic

minutes to 15–30 minutes due to self-ligating brackets and

dependent on the percentage of patients treated with

the patient day. I have done this in a few different ways,

field, I am amazed by the changes in the industry. In 1975

improved arch wires.

aligners.

depending on what method works best for the doctor and

In 1997 Invisalign entered the profession, offering

A percentage of the aligner appointments can also be

removable aligner treatment as an option for full treatment.

done virtually, rather than in-office. This helps to reduce

Currently, more than 5,000,000 patients have been treated

the number of patients seen on a daily basis (especially

using Invisalign. This does not include patients who are

more important now while dealing with COVID-19 safety

uninterrupted time to complete the treatment plan and

treated with clear aligners, available through companies

guidelines).

ClinCheck. The team continues to see patients during

I worked with a general dentist who offered “orthodontic”
treatment for children. His treatment of choice was to
extract four permanent bicuspids and then close the space
with Hawley retainers. I had the same treatment done by
a general dentist when I was 12-years-old. The result was
far from ideal, and it limited my treatment options when I
decided to be re-treated by an orthodontist as an adult.

often seen every 8–12 weeks, reducing the number of

When I started in the orthodontic field in 1978, treatment

appointments over the active treatment time to 10–14.

typically involved banding the six- and twelve-year molars,

Aligner treatment has transitioned from adult only

and then bonding the rest of the teeth. Starting a patient

treatment to teenagers and children.

took multiple appointments over several weeks. The
sequence of appointments was as follows:

have found to work best are:
1.

or seeing patients for non-doctor procedures (scans,

treatment can accommodate more patients per day, due

records, delivering initial aligners – where the doctor is

to the decreased chair and doctor time. Although this may

not needed until near the end of the appointment, etc.).

sound great, there are additional considerations to consider.
One is the lab fee, which is sometimes as high as $1,850

Block out 45–60 minutes per day for the doctor to have

this time, however they are either finishing a procedure

When I design scheduling templates, doctors using aligner

2.

Build in 10–15 minutes of doctor time at the end of

So, what does this mean to orthodontic practices that

per case. Although, in the long run I have found Invisalign

each aligner scan to allow the doctor to complete the

are now treating 30-70% of their patients with aligner

can be more profitable, it can be very expensive for doctors

treatment plan and ClinCheck for the patient at the
time of the procedure.

1.

Initial exam

treatment? The result is that you can start more cases, as

to start patients. As the number of aligner starts increases,

2.

Full records

active aligner patients are scheduled on a longer rotation.

fortunately the lab fees decrease, depending on the number

3.

Consultation

Your production can often increase 20-50%, as you have

of starts per quarter and year. When you weigh the cost over

4.

Separators

opened time in your schedule by reducing the number

the time saving, many doctors find that they can be very

5.

Band the molars

of times a patient is seen during their treatment time.

profitable, despite the increased cost.

6.

Bond the remaining teeth and place arch wires

Other than the initial placement of aligners, refinement

3.

Train a key clinical team member to be your Invisalign
coordinator. They would work closely with the doctor
to help manage ClinChecks during the time which is
blocked out on the schedule. The Invisalign coordinator

More importantly, I see doctors struggling to find the time

would also manage the Invisalign correspondence

to treatment plan and submit the ClinCheck to fabricate

and track scans, aligner deliveries, and refinements. In

the aligners. Unfortunately, many doctors are trying to

addition, they would run the deband monitor at the end

that most patients were seen 32+ times over the course of

Over the past year, approximately 60% of my clients have

get this done over their lunch time, after work, and on

of each month to track aligner profitability.

their treatment, excluding the retention phase. Scheduling

increased the number of patients they treat with aligner

the weekends. The chair time per patient has decreased,

logistics limited the number of active patients due to the

treatment. Many doctors have made the decision to offer

however the doctor is spending more time on behind the

frequency of appointments needed to complete their

aligner treatment to many of their patients, including

scene aligner treatment plans.

treatment.

teenagers and children.

Gradually throughout the years, practices transitioned to

This can have a big impact on your patient schedule.

orthodontic practices. Often, when I am contacted by a

taking records at the initial appointment. In most cases

The long bonding appointment has been replaced with

potential client, their goal is to streamline the schedule. This

the formal consultation has been eliminated, unless it

the initial placement of attachments and aligners. This

is often accomplished by creating a doctor-time schedule,

is a difficult case, or it was determined that the patient/

procedure requires very little doctor time, as typically

allowing the doctor to be needed at only one chair at any

Debbie Best, senior practice management

parent required additional information prior to the start

the clinical assistant places the attachments. The doctor

given time. It reduces stress on the doctor and team, as well

consultant and lecturer for Debbie Best,

of treatment. Additionally, many doctors are eliminating

removes the excess flash and checks the fit of the initial

as helps to ensure that patients are seen on time and the

Consulting Network has over 45 years of

the use of bands and bonding patients 7–7. Patients are

aligners. This has reduced the time needed for the start

appointment ends on time.

experience in the dental and orthodontic

often given the opportunity to start treatment at the initial

appointment from an average of 90–120 minutes down

appointment, reducing time missed from school or work.

to 45–60 minutes. With the decrease of the number and

Many orthodontists now see patients every 6–10 weeks,

length of visits required for aligner patients, it can often

reducing the number of appointments from 32+ to 20 or

open up one or more hours per day for each patient

less. Chair time for patients has decreased from 30–45

chair. The result is that you can see more patients per day,

After the patient was fully banded, they typically were
seen every 4 weeks for a period of 2–2 ½ years. This meant

8

other than Invisalign. Patients in aligner treatment are

team, their treatment style, and philosophy. The options I

appointments and deband, the average chair time for
aligner visits is 10–20 minutes.

Over the years, I have created templates for hundreds of

With the strong influx of Invisalign or aligner treatment,
I have found that it is beneficial to adapt the schedule to
allow time for the doctor to complete the behind the scene
task to treatment plan and submit the ClinCheck during

Although there is an added expense up front, I have
found the Vivera retainers to have the potential of being
Align Your Practice continued on page 14

About the Author

field. Debbie evaluates staffing needs and
the office computer system to develop a
strategic plan for practice productivity.
Contact Info: debbiebestconsulting@gmail.com • 206.310.6055
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INSIDE ORTHO2
Information about the people of Ortho2 and the resources available to you as a member

FREE WEBINARS

CAREER MILESTONES AND DEVELOPMENT

We offer you free, online webinars each month throughout the year on various topics. It’s a great solution for training new

The Software Support Team has two new members. Chloe Enos and Michaela Henke joined Ortho2 on November 2.

users, refreshing experienced users, or learning about new features. Webinars are available online at www.ortho2.com > Our
Company > Ortho2 Webinars. Find the topic for the month and click the link to view the webinar at your convenience.

Upcoming Webinar Topics

Chloe is a recent graduate from Iowa State University with a Master’s of Art in graphic design and a Bachelor’s of Design.
Prior to joining Ortho2, Chloe was a freelance graphic designer and an art tutor.
Michaela is also a recent graduate from Iowa State University with a Bachelor’s in biological and pre-medical illustration.
Michaela gained customer service experience while working at Wild Birds Unlimited before coming to Ortho2.

January – Edge Cloud: Open-ended Contracts

attending, directs the doctor to the next patient that should

In some instances, you may need to create contracts without
an end date. You can create open-ended contracts in Edge
Cloud to accomplish this. This webinar will review the steps
for creating and managing this type of contract.

be seen, and alerts you to patients that have been waiting
an extended period of time. We will demonstrate how to
access the widget, choose your settings, and use the light

ON A PERSONAL NOTE
Congratulations to Jess Huennekens, Ortho2 Regional Manager, and his wife, Jessica on the birth of their son Elliott Roland

bar.

on November 24. Elliott is joined at home by big brother Liam. Congratulations Huennekens family!

February – ViewPoint: Light Bar Widget

March – Edge Cloud: Edge Specialist Set Up

November 24 was a busy day for new family members. Steve Volcko, Ortho2 Regional Manager, and his wife, Emily,

This webinar will walk you through the steps you need to

home by big brother Emmett and big sister Stella. Welcome to the world, Viv!

Use your Light Bar widget to monitor the doctor’s

take to get Edge Specialist ready in your practice. We will

involvement with patient appointments once they have

review how to set up your editors, dental procedure groups,

been processed as “seated” in your On-Deck Operatory.

insurance fee schedules, appointment types, and treatment

The light bar notifies you about who the doctor is currently

chart styles.

welcomed their daughter Vivian (Viv) Olivia that day as well. She was 20 inches long and weighed 7 lbs., 2 oz. Viv is joined at

ORTHO2 ANNIVERSARIES
Congratulations to these Ortho2 staff members who celebrated anniversaries during the fourth quarter of 2020.

Twenty-Eight Years

Sixteen Years

Seven Years

Todd Schuelka

Corey Schmidt

Steve Volcko

Twenty-Six Years

Fifteen Years

Two Years

Michele Eich

Derek Dohrman

Paige Seward

Twenty-Two Years

Eight Years

One Year

Lowell Davis

Brian Good

Dylan Groves

Denise Sargent

Drew Humphrey

Jennifer Shaffer
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Elliott Roland
Viv Olivia

SERVICE EXCELLENCE
We invite you to recognize Ortho2 employees by completing an Extra Mile card. Simply fill one out online by going to www.
ortho2.com > Our Company > Contact Us. Our goal is to uphold our tradition of excellence in customer service, and with
our Extra Mile program, you can let our employees know when you appreciate their extra effort. We encourage you to send
an Extra Mile card whenever an Ortho2 employee goes the extra mile for you. The recognition is valued by the recipient
and is acknowledged by our management team. We continue to look for better ways to serve you. Thank you for helping us
recognize excellence.
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INSIDE ORTHO2
Information about the people of Ortho2 and the resources available to you as a member

MEET THE TEAM – SOFTWARE SUPPORT

RETRAINING

Any time you have a question about Edge Cloud or ViewPoint, there are many specialists available to assist you. The

Have you hired new staff since your original software training? Have you had staff members take on new responsibilities? Do

Software Support Team takes your calls to answer your questions, assists in enhancing your software, and trains new offices.

you feel you might not be taking advantage of the enhancements that have been added over the years? Ortho2 offers many

This quarter features Dylan Groves, Software Support Representative and Jo Jacobson, Software Support Manager.

options for refreshing your knowledge of old features and informing you of new features, but do you want to be able to set
your own agenda to meet the specific needs of you practice?

What do you do here at Ortho2?
DG: I provide software support to end users. More or less, I

If I were to pick a favorite, I would say that I most enjoy
interacting with new people every day.

talk to people and answer their questions.

JJ: It’s challenging and interesting every single day.

JJ: As the Software Support Manager, I work with the

What do you want our users to know about what you do?

Software Support, Advanced Support, and New Customer
Care teams.
What’s fun/what do you enjoy about your current job?

A retraining – either in your office or over the Internet – addresses all these issues. To learn more and to schedule one for
your practice, contact your Ortho2 Regional Manager today at sales@ortho2.com or 800.678.4644.

DG: There are no stupid questions.

HELP US HELP YOU

JJ: It’s a large and diverse group of good people who strive

Please be prepared to provide your customer number, practice name, and office location when you call our support teams

to provide the best possible service to Ortho2 customers.

for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you use ViewPoint, you will

DG: There’s a lot that I enjoy about my current role here.

find your customer number by clicking the Help menu and choosing About. Please be sure to provide this information—and
repeat your phone number—when leaving a phone message requesting support. Having clear information helps us serve
you more quickly.

Dylan Groves

Jo Jacobson

Vacation destination: The Amalfi

Vacation destination: A cabin on a

Coast

lake

Three people I would like to have

Three people I would like to have

dinner with: My Father, Joe Rogan,

dinner with: Mom, Grandma, and

and Ed Snowden

SUPPORT
By Phone: 800.346.4504

And Don’t Forget Our Website: www.ortho2.com

Available 7:00 A.M. – 7:00 P.M. Central

Our website gives you 24/7 access to our knowledge base, FAQs, white

Grandpa

Time, Monday – Friday

papers, visual help videos, and more.

My role model: My father, Stanley

My role model: Mike Jacobson. A

W. Groves

salt of the earth guy and the kindest

By Email: ortho2support@ortho2.com

I can’t go a day without: The gym

person I know.

What are you listening to right now? The Miseducation of

I can’t go a day without: Planning out the next renovation or

Lauryn Hill

garden project – I have endless ideas.

Favorites

What are you listening to right now? Pandora: Symphonic

Team: University of Georgia Bulldogs

Radio mix

Software Program: Steam

Favorites

Movie: The Matrix

Software Program: Ortho2 Edge Cloud

Book: The Iceman: Confessions of a Mafia Contract Killer by

TV Show: Currently working my way through Ozark season 3

Philip Carlo

Book: Currently reading a lot of Pete the Cat adventures with

Phone App: Instagram

my grandson
Phone App: Lately, a lot of online shopping apps

Response time is usually the same day or
at most within 24 hours.

CHAT SUPPORT
Do you need to call into our Support Team for a question, but it’s difficult to wait on hold, even for a few minutes? Ortho2
has you covered! Use our chat support to get in contact with us. When you use the chat support feature, you will be added
to the same queue as phone calls. You can choose to chat with the Software Support, New Customer Care, or Network
Engineering Teams.
In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint version 11 and beyond, it is the
bottom right Help button in the Daily Activities menu.
So drop us a line when you are in a pinch! We are here to help you in whatever way is most convenient for you.
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President’s Perspective continued from page 1

Terrific Thoughts continued from page 6

Ortho2’s new virtual appointment solution, a couple

follow up steps. inVisit lets you communicate with patients

newsletters ago when it was first released. This latest

at times that work best for you and them. Once the virtual

innovation will streamline the way you interact with your

appointment is completed, set patients’ status according

patients, today and into the future. inVisit allows you to

to what you want to do at the next virtual or in-office

virtually conduct appointments with both current and

appointment. With inVisit, you control the number of in-

prospective patients. Patients can fill out questionnaires

office visits your patients need to make. Start using inVisit

regarding desired or current treatment, and take a series

today, and get your first month for only $30. Sign up at

of photos of their teeth. You can review progress of current

www.getinvisit.com.

patients from the inVisit dashboard to determine the next
steps for treatment. Information from prospective patients
can be viewed to determine if care is needed and establish

I hope these new additions help you and your practice thrive
in 2021 and beyond.

Amy Schmidt

smile. Biggest change I see here? When I’m chairside I’ve

positive is that our doctor has become more brief and

always asked my patients how they are doing, but now more

concise with our time-eater patients/parents. Our team came

often, they ask about me!”

back willingly without complaint, keeping our morale up and
numbers healthy. With no more spending on vacations/trips
to Disneyland, parents now spend money on smiles! Biggest
thing I learned? I see the impact this pandemic has had on

You can remove the gender symbol at the top of the

Automate Stacks

patient chart by going to User Options > Visuals >

•

Alex, Clinical Coordinator Specialist/RDA, “Hey, I have a
job! I have more family time; my kids are healthy and are
back into school now and happy to be there. Our team all
wanted to come back as soon as we could and we are so
grateful to have our jobs. Our doctor didn’t have to pick and

Michelle, Scheduling Coordinator, “I sure am more in

choose who he wanted back. We were already a great team,

tune with the flow, number of appointments, people in the

and that stayed the same. He took all of us back; we are all

reception now – it’s so important! We find people can cancel

really good, and we are all here 100%. What sticks out to

more easily and at the last minute because they don’t feel

me? Sure I hate that I can’t go out to places or watch sports

well. We know our patients value the appointments they

events, but the positives far outweigh the negatives that this

keep more and the time the doctor spends with them. Best

virus brought on.”

thing I see? I now feel more important and valued here

Edge Cloud Tidbits continued from page 4

watching the patients and our schedule closely.”

Cat, Health Concierge, is a new employee hired recently
to welcome patients, take temperatures, and guide them

Reports are great, but why run reports every day to find

Elizabeth, Financial/Insurance Specialist, “This virus did

on today’s process. She brilliantly told me she needs to,

uncheck Display Gender Symbol in Patient Folder

a list of patients who need follow up? Create a workflow

not make me fear losing my job or being financially hurt. I

“Be kind to patients as they are anxious/worried and want

Header.

to automatically add the patient to a stack. Common

stayed confident, was able to still do my work solo through

to be told about the enhancements made and cleanliness

examples include: adding patients to a stack after a

it all. Sure scheduling is now harder, we had to hire another

guaranteed to them at each appointment. Consistency is

consult to remind the TC/Dr. to write up the treatment

person, and the pediatric dentistry part of our practice was

critical and talking to them about how we are glad they

plan; when scheduling an exam, add the patient to

impacted, especially by our six-month recall schedule. But,

are here is my job. But, I’m really in the customer service

a Verify Insurance Stack; and care calls on multiple

like I bet others have told you today, I am so grateful to be

business more than anything.” Wow, you all need a Cat on

appointment types.

here to take care of it all!“

your team.

Gina, Treatment Coordinator, “What a way to get more

And remember, flexible people never get bent out of shape.

quality and quantity of time with my family! Now I am

This terrific team has been flexible in just about everything

so much more appreciative of life and nature and the

and is coming out on top in just about every area of practice

friendships I have. Sad I can’t be with people more and have

life because of it.

New Patients and Fast Find Window
•

to wear this mask around my patients who want to see my

from work. All my family time has become far better. A

others outside of orthodontics. We are so lucky.”

Amy Schmidt, Ortho2 President

•

home and she has dinner ready for me when I get home

When taking that new patient phone call, search for the
patient in the Fast Find window first to verify they are
not already in the system. When they are not, simply
click Add New in that same window, to pull up the New
Patient window.

Align Your Practice continued from page 9
more profitable. The retainers require very little doctor

multiple treatment options, from seeking a trained

maintenance, thereby freeing up your schedule to new starts

specialist to having treatment done by a general dentist.

and active patients. Since the patients have extra retainers in

When you throw consumer direct aligners into the mix

Technology continued from page 7

reserve, it reduces the number of patients who are seen for

(SmileDirectClub, Candid, SmileLove, etc.), it is more

retreatment.

important than ever for orthodontic practices to step up

Video gatherings for CE or fun with local dentists help you

Think outside the box, use technology to further your brand

stay relevant in your community. Finally, get involved with

and connect with your community. We will all get through

local businesses owned by your patients and ask how you

this together.

Scheduling templates have changed due to COVID-19
regulations. I recommend leaving 5–10 minutes between
procedures in any given chair. It is also beneficial to stagger
chairs, so you don’t have patients, seated in adjacent chairs,
arriving or leaving the clinical chairs at the same time.
Embrace the future of orthodontics. Patients have

14

their game to attract and retain new patients. Once we
get the new patient through the door, wow them with
exceptional customer service provided by a specialized
orthodontist. As well as taking excellent care of the patient,
respect the doctor’s personal time. Say good-bye to working

can help them during these times. Coming together as a
community is one of the best ways to grow your practice
brand and become ‘the practice’ in town.

nights and weekends, giving orthodontists more time and
space to recharge their batteries.
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